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1. Description

1.1. Difference: WinProgrammer & MapMyKey
Basically, there are two tools to program a PrehKeyTec keyboard:

Ry Q..
WinProgrammer.exe MapMyKey.exe

When programming with the WinProgrammer, By contrast, when configuring with MapMyKey,
the configuration is always stored directly in the  the configuration of the keyboard is stored

keyboard itself. directly on the workstation (PC) on which the
That means: MapMyKey software is running.

If you configure your keyboard with the That means:

WinProgrammer, the keyboard can be used at If you configure your keyboard with MapMyKey,
any workstation (PC). the keyboard can only be used at the

workstation (PC) where it was configured.

Conclusion:
Thus, the basic difference between the two tools is that the intelligence in the configuration via
WinProgrammer is in the keyboard, while the configuration by MapMpyKey in the workstation (PC).

1.2. How MapMyKey works
MapMyKey is a configuration tool for PrehKeyTec devices. The software runs mainly in the
background and automatically starts by default after Windows® user logon.
Only the keys, which are assigned with a so-called "POS-Key", can be configured with MapMyKey.
If these are not yet programmed on the keyboard, this can be done with the WinProgrammer.

1.2.3. What is a "POS Key"?

If a key is assigned a "POS-Key" via WinProgrammer, it will send "invisible" key-codes to the PC when
the key is pressed.

Thus, a "POS key" is an "invisible" key code for the system.

Unlike the Windows® system, MapMyKey recognizes these POS keys.

Each key that is assigned a POS key can now be assigned any functions with the Mapper. These
configurations are stored in files (* .pmap).

If a button assigned with a POS key is pressed and configured in the file opened with the mapper

(* .omap), MapMyKey translates the received POS key into the correspondingly configured function.

Incidentally, the same also works with the data from modules such as OCR, MSR, barcode and
keylock.
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1.3. Advantage of MapMyKey

Due to the functional principle of MapMyKey described above, there is a decisive advantage:

Since the intelligence, or the implementation of key presses in the desired actions, takes place on the
PC, not only the keys / modules certain actions can be assigned, but these actions are also made
dependent on certain processes.

For example, an action can be assigned to a specific process. If you press the corresponding key, the
action is only executed if the corresponding process has the focus.

Example:
If an action is assigned the "notepad" process, it will only be executed if the user is in a window of
the text editor, in other windows, such as Word, Excel, etc., this button is ignored.

2. Hardware Requirements
MapMyKey can only be used with USB devices from PrehKeyTec.
These include the ML2 (A) and PKT4000 document readers as well as all programmable USB
keyboards.

IMPORTANT:

The keypads must be assigned POS Keys. If this is not the case, this can be done with the tool
WinProgrammer.exe.

This can be downloaded from our homepage at:
https://www.prehkeytec.com/support/keyboards/

3. System Requirements
Your system needs the following requirements and installed components to run MapMyKey:

Windows® 7 (x86/x64) (or higher)

Microsoft® .NET Framework 4.0
Download: https://www.microsoft.com/de-de/download/details.aspx?id=17718

Microsoft® Visual C++ 2010 Redistributable Package
Download (x86): http://www.microsoft.com/en-us/download/details.aspx?id=5555
Download (x64): http://www.microsoft.com/en-us/download/details.aspx?id=14632
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4. Installation

To install MapMyKey, run ‘MapMyKey Setup V*.exe’ with administrator privileges and follow the
instructions in the installation.

During the installation, various templates are installed in addition to the software. Furthermore the
MapMyKey’s file type “*.pmap’ will be registered, which can be recognized by the following file icon:

5. Uninstall

To uninstall MapMyKey, go to Control Panel, Programs and Features and uninstall the ‘MapMyKey’
component.
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6. Using the software

6.1. Create a new file
To create a new MapMyKey file, on the ,File’ menu, click ,New".
Choose a standard template, or select your custom WinProgrammer file (* .mwf) that you previously
created with the WinProgrammer tool and loaded into your PrehKeyTec keyboard.

The WinProgrammer is the programming tool for PrehKeyTec devices and can be downloaded from
the following link:
https://www.prehkeytec.com/support/keyboards/

Choose a standard template, or select your custom WinProgrammer file.

Choose a standard layout template

MCI30 MCI60 MCl84 MCI96 MCIT11A MCI128 MCI128A_G  MCIl124

< >

Choose a customized layout template (*. mwf) ...

Cancel

Next, specify the location and file name under which to save the new MapMyKey file.

In addition, the checkbox "Key-Click" can additionally be used to set whether the keypad
acknowledges the pressing of the keys with a short beep tone.

Enter the location and name of the new file

Storage Location: |C:\ProgramData\PrehKeyTec\PKT MapperiMappingLists
File Name: Imci3q)
Key-Click

After clicking on "OK" the new MapMyKey file will be generated and opened.
This can take a moment.
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6.2. Open an existing File
If you want to open an existing MapMyKey file (* .pmap), on the ,File’ menu, click ,Open’ and select
the file you want to open.

You can also open one of the recently opened files in the ,File > Recent Files’ menu or simply drag a
MapMyKey file into the window of MapMyKey.

6.3. Automatic device detection
If the function ,Device Detection’ is activated in the ,Settings’ menu, MapMyKey recognizes the
currently connected devices automatically and you can now directly create a new file with the
corresponding template file.

B MapMyKey — m] X
File  Edit Modules Settings Help
Ef = X D o
New Open Close Recent Files Exit
v
PrehKeyTec

MapMyKey - Device Detected

MCI30 detected

Open a IVIapM Do you want to create a new file for this device now? to the window.

Create New File
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6.4. Close File
To close the opened MapMyKey file, click on ,Close’ in the ,File’ menu.
The mapping stops automatically after closing the file.

6.5. Exit or minimize MapMyKey
To stop MapMyKey, click on ,Exit’ in the ,File* menu.

If MapMyKey is closed, no mapping takes place.
If MapMyKey should continue to run in the background, then only minimize the window of
MapMyKey.

The application disappears into the background and can be brought to the foreground via the
MapMyKey icon in the notification area of the taskbar.

6.6. Change Language
To change the language of the user interface, click on the desired language in the ‘Settings’ menu.
For the change to take effect, MapMyKey must be restarted.
This happens automatically if desired.

6.7. Autostart settings
By default, MapMyKey launches automatically after logging in with your user on the Windows®
system.

In addition, after the autostart, the last opened file is automatically reopened and the window of the
MapMyKey is minimized.

These settings can be changed at any time via the ‘Settings’ menu.
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6.8. Display
After opening a MapMyKey file, it will be displayed as in the following window.

File  Edit  Modules Setiings Help
e L L]
I i i 8] [& @
Copy Key Paste Key Delete Key Change Layout Export as PDF Open Template File Recovery
v
L) - - -
Heylodk: i} 1 2 a 4 5 ﬂ

POS POS POS POS POS
026 027 028 029 020
® Always POS POS POS POS POS
021 022 023 024 025
POS POS POS POS POS
018 017 018 019 020
Hello ';I Preh
- H Z?j. -
Shift up Ccrl A D'Z'Et
Left Down Right Copy Paste

Q 75 % ®\ C:\ProgramData\PrehKeyTec\PKT MapperiMappingListsimci30.pmap

In addition to the keyboard layout, various modules are also displayed. These can be found directly
above the keyboard. It may happen that modules that are not installed in your keyboard are
displayed. It may also be the case that modules installed in your keyboard are not displayed.

If this is the case, the corresponding modules can be added or removed at any time in the menu
‘Modules’.

When removing a module but also all functions of the module are irrevocably deleted.

If the display of the keyboard is too small or too large for the window, the display can be reduced or
enlarged in the status bar, or with the combination CTRL + mouse wheel.
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6.8.1. Process Layer
A key can have any number of functions. It is crucial which process currently has the focus.

If a button is assigned a function for a certain process, this automatically appears in the list on the
left after saving.

In the main view, the functions of all buttons are shown as follows:

Key can not be used because no POS key is programmed on it.

The button is not assigned any functions.

Button is highlighted.
The button is not assigned any functions.

Preh

Key The button is assigned a function for the process selected in the left column.

Tec

Preh

Key Button is highlighted.

Tec The button is assigned a function for the process selected in the left column.

Preh . . . .

Key The button is not assigned a function for the process selected in the left column, but

Tec for a different process.

Preh Button is highlighted.
Key The button is not assigned a function for the process selected in the left column, but
Tec for a different process.

6.8.2. Rename/Delete Process
With the help of the two buttons in the left column of the main view, a process for all buttons can be
globally renamed, or the functions for a process on all buttons can be deleted.
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6.9. Assign function (key / keylock)
By double-clicking on the key or the keylock position, the following window opens in which you can
edit the functions of the key / keylock.

POSKEY 014 x
Process: Presentation
® Always
Key Color ® Key Label: O Image:
- Text Color
Font

® O O O
No Action Text/Hotkey Run Application Open Website

I BN EE KN

Delete POSKEY 014 Save

The representation of the key can be edited in the ‘Presentation’ box. The key can be labeled either
with a text or with a picture.
In addition, the font as well as the text and background color of the key can be changed.

A key can have any number of functions. It is crucial which process currently has the focus.

By default, the function of a key is performed independently of the focused process. To do this,
select ‘Always’ in the left-hand column.
This can not be renamed or deleted.

The label of the key applies equally to all functions of the key.
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If you want to add a function for a certain, not yet existing, process, click on the button ‘+’ on the
bottom left.

Key Color @ Key Label: O Image:
- Teat Color 1
Fort
Function
e Procese X o o
nter Frocess Name Run Application Open Website
|notepad:Unbenannt—Editor | ﬂ -
| | notepad
PET Mapper 3
explorer 3
| notepad 4 Unbenannt - Editor
SnippingTool 3
SystemSettings 3
ApplicationFrameHost  »
WinStore.App 3

Double

Delete POSKEY 014 S

@ 75% & C:)\ProgramData\PrehKeyTec\PKT MapperiMappingLists\mci30.pmap

Enter a process name to which you want to restrict the function.

Would you also limit the function next to the process to a certain window title of the process, add
the window title with a ':' separated in the process name.

The button next to the text box lists all existing processes, as well as all open processes and window
titles. With a click on the desired process / window title, it is transferred to the text box.

When pressing the key, only the function whose window title is contained in the title of the window
which has the current input focus is executed. Otherwise, no action is taken. Similarly, the case does
not matter. Several title parts can be enumerated by further separations with a *:’.

In addition, by clicking on ‘+’ several process levels can be created simultaneously.
After clicking on ‘Save’ the new layer will be added and selected.

Now this can be configured.

Similarly, a window title can be renamed, copied, or deleted.
But this has only impact on the selected key.

The window titles of all other buttons remain unchanged.
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If one of the following three functions is assigned to a process, the lower checkbox ‘Bring window to

foreground’ can be used to bring the window of the selected process to the foreground before the
function is executed.

6.9.1. Function: Text/Hotkey
This function outputs text and / or keyboard shortcuts when the selected key is pressed.

POSKEY 011 x
Process: Presentation
O Always
® nolezad Key Color @ Key Label: O Image:
- Text Color Hello
Fort v

O ® O @]
Mo Action Text/Hotkey Run Application Open Website
=

Common Macros: Text Qutput:

{Alt @ Record keystrokes
{App}
[Backspace} Hello Notepad {DELAY1000}

[Break} have you seen the new PKT Mapper software from PrehKeyTec?
{Browser_Back} {ENTER}

{Browser_Favorites

B F d
EB :gx:g_'_g::z; i Configure the text to be output when POSKEY 011 was

[Browser_Refresh} received.
{Browser_Search} +

The macros in the lists can be inserted by drag and drop.

Bring window to foreground [ Auto Repeat [ Slow Output

Delete POSKEY 011 [

You can either enter the text output manually or drag and drop various standard macros and
combine. The well-known spelling from the WinProgrammer applies here.

You can also use the button "Record keystrokes" to easily record the desired key combination and
enter it in the text box.

Another click on the button (or in the POS key window) ends the recording and, if desired, creates a
new process layer in which the keystrokes were recorded.
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By default, a POS key is only executed once when pressed. If you want the key to be kept pressed
while pressed, you can activate the checkbox "Auto Repeat".

Sometimes it is necessary to output a text sequence or a shortcut a little more slowly.
To do this, activate the checkbox "Slow Output".

6.9.2. Function: Run Application
This function executes an application when the selected key is pressed.

POSKEY 013 B
Process: Presentation
® Always
Key Color O Key Label: ® Image:
- Text Color
. — /

O ®
Mo Action Text/Hotkey Run Application Open Website
=

Applications: Run Application:
C:\Windows\SysWOWE4\notepad.exe:/q ,fs|

&%) 7-Zip File Manager
18 7-Zip Help

FllAccess

Bl Acrobat Reader DC
%) Android Studio

¥ Apple Software Update
L WY " . e e LYY XYY

< >

Double click on an application from the list or enter
an application.

Bring window to foreground

Delete POSKEY 013 Save

You can manually enter the full path, double-click an application from the list, or search for an
application.

If parameters are to be passed to the application, they can be appended after the “::" after the
complete program path.
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6.9.3. Function: Open Website
This function opens a web page in the browser when the selected key is pressed.

POSKEY 013 %

Presentation

® Alwa
= Key Color @ Key Label: O Image:
- Text Color Preh
Font ‘:{

O O @] ®
MNo Action Text/Hotkey Run Application Open Website
=
Website:

www.prehkeytec.com

@® Standard Browser O Mozilla Firefox O Google Chrome O Internet Explorer
O Microsoft Edge

Bring window to foreground

Delete POSKEY 015 Save

To do this, manually enter the complete URL or insert it.
You can also choose to open the URL in the default browser or in a specific installed browser.

6.9.4. Save changes
If you want to save all changes to the key, click ‘Save’.
When saving, all window titles to which no action has been assigned are automatically deleted by the
key.

6.9.5. Delete all functions
If you want to delete the complete key (all functions and the label of the key), just click on ‘Delete
POSKEY XXX'.

The functions of the key are irrevocably deleted.
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6.10. Assign function (MSR/OCR/Barcode)
By clicking on a module button (‘MSR’, ‘OCR’, ‘Barcode’), one of the following windows opens in
which you can edit the function of the module.

With the modules one either has the possibility of outputting the data on receipt as keystrokes or of
storing the data in a file.

As with the keyboard output of the keys, one can either enter the output text manually or insert and
combine various standard and module macros by drag and drop.

Upon receipt of module data, the special macros inserted in the ‘Text Output’ field will be replaced
by the corresponding received data.

6.10.1. Output as keystrokes

M5R Module x

MSR Macros: Common Macros: Text Output: @ Record keystrokes

{MsrTrack1} (Al Data from Track1{TABYMsrTrackl}
{MsrTrack2} {App} Data from Track2{TABHMsrTrack2}

{MsrTrack3} {Backspace} :
{Break} |Data from Track3:{TABH{MsrTrack3}

{Browser_Back}
{Browser_Favorites
{Browser_Forward}
{Browser_Home}
{Browser_Refresh}
{Browser_Search}
[Browser_Stop} ® Output as keystrokes

Configure the text to be output when MSR data has been received.
The macros in the lists can be inserted by drag and drop.

Execute only if following process has the focus:

|notepad | E

Bring window to foreground [ Slow Output

O Save data to file

Filename

Overwrite Append Increase Filename

The keyboard output can be restricted to a specific process. Likewise, the checkbox ‘Bring window to
foreground’ can also be used that the window of the selected process is brought to the foreground
before the configured text is output as keystrokes when the module data is received.

The Record Keystrokes feature works like the keys.

Keyboard output can also be slowed down here with the "Slow Output"” checkbox activated.
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6.10.2. Save data to file

M5R Module x

MSR Macros: Common Macros: Text Output:

{MsrTrack1} Data from Track1-{TAB{MsrTrack1}
{MsiTrackz} Data from Trackz:{TABHMsiTrackz}
{MsiTracks} Data from Track3:{TABHMsrTracks}

Configure the text to be output when MSR data has been received.
The macros in the lists can be inserted by drag and drop.

O Output as keystrokes

xecute only if following process has the focus:

|n0tepad | E

Bring window to foreground

@ Save datato file

Filename:

st |

® Overwrite O Append O Increase Filename

Enter a complete file path including the name and file extension into which the configured text
should be saved upon receipt of the module data.

You can also choose between the following options:

‘Overwrite’
Receiving new module data overwrites the specified file.

‘Append’
When new module data is received, the new text is appended to the contents of the specified file.

‘Increase Filename’

When receiving new module data, a new file is created, with the specified file name being
incremented.

Example: "Barcodel.txt", "Barcode2.txt", "Barcode3.txt", etc.

The Record Keystrokes feature is not available here.

6.10.3. Save changes
If you want to save all changes to the key, click ‘Save’.

6.10.4. Delete module function
If you want to delete the module function, just click on ‘Delete XXX'.

The function of the module is irrevocably deleted.
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6.11. Change layout template (*.mwf)
It is possible that you change your MWEF file using WinProgrammer because, e. G. to move a key,
change the size of a key, etc.
In this case, you do not have to duplicate the work and move the functions in your MapMyKey file as
well.
You can simply select the changed WinProgrammer file (* .mwf) via the menu ‘Edit 2 Change
Layout’.
The layout will then be updated in the MapMyKey file. The functions are all retained and may be
moved to the new key positions automatically.

6.12. Activate / deactivate key tones afterwards
In order to subsequently deactivate / activate the key tones, use the previously described function
"Change layout template ".

There, when selecting the layout template, the key tones can be deactivated / activated with the
checkbox. (Just like when creating a new file)

6.13. Open another file as a template
If you have already created a MapMyKey file and would like to use keys created in it in your new file,
you can open this file as a template.

Simply click on ‘Open Template’ in the ‘Edit’ menu and select the desired file.

This will now be opened in a separate window. From there you can drag and drop the desired
buttons to the desired position of your new file.

6.14. Change Date Format
For text output and modules, there are certain macros that output a date.
For this, the desired output format can be specified.
In the ‘Settings’ menu, click on ‘Change Date Format’ and enter your desired date format in the
following window.

Date Format x

Enter Date Format:
|MM-dd-yy] |
(e.g. MM-dd-yy)

"d" The day of the month, from 1 through 31.
“dd" The day of the month, from o1 through 31.
"ddd" The abbreviated name of the day of the week.
"dddd" The full name of the day of the week.

"M The month, from 1 through 12.

MM The month, from o1 through 12.

MMM The abbreviated name of the month.
“MMMM® The full name of the month.

“yy The year, from oo to gg.

“yyyy" The year as a four-digit number.
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6.15. Export key labels as PDF
Another feature of MapMyKey is that you can easily export the labels of all buttons that have a
function to a PDF file.

In the PDF file, the keys are sorted by key size. You can now easily print, cut and label the keys on
your keyboard.

This function can be found in the menu ‘Edit = Export as PDF’.

MapMyKey - [} ®
File  Edit  Modules Settings Help
e L L]
& i i IS [@ @
Copy Key Paste Key Delete Key Change Layout Export as PDF Open Template File Recovery
v
L) - - -
Keylod: a 1 2 3 4 ) ﬂ
Export as PDF

@ Always Storage Location C:\ProgramData\PrehKeyTec\PKT Mapper

File Name mci30.pdf

The key labels are now exported. Please wait

Hello FOS Preh
to oy 014 Key

Delet

Shift Up Cirl A

Left Down Right Copy Paste

Q 75 % ®\ C:\ProgramData\PrehKey Tec\PKT Mapper\MappingListsimci30.pmap

6.16. Check for updates
MapMyKey checks if a new software update is available and displays it in the status bar. This check
can be deactivated in the menu "Help—> Check for updates".
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6.17. File Recovery/Undo
MapMyKey saves every change made after opening a file. To undo a change, you can restore the
desired state of the change under "Edit-> File Recovery".

Click on the arrow at the end of the corresponding line to restore the desired state.

C:\ProgramData'\PrehKeyTec\PKT MapperiMappingLists\imci30.pmap

Timestamp Changes

15.07.2020 - 14:26:21.358 | Started File: C:\ProgramData\PrehKeyTec\PKT MapperiMappingLists\mci30.pmap
15.07.2020 - 14:35:38.453 |POSKEY 13 moved action to POSKEY 18

15.07.2020 - 14:35:40.085 | POSKEY 12 copied action to POSKEY 14

Cancel
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7. Settings.xml

All settings that are changed in the mapper are saved in the following XML file:

%APPDATA%\PrehKeyTec\PKT Mapper\Settings.xml

In addition, there can be made a few more settings that optimize the behavior of MapMyKey:

<POSKeyMapper>
<SETTINGS>
<SET>
<MasterSettingsFile></MasterSettingsFile>
<Autostart>FALSE</Autostart>
<OpenlastFile>TRUE</OpenLastFile>
<DeviceDetection>TRUE</DeviceDetection>
<CheckUpdates>FALSE</CheckUpdates>
<OpenFile>C:\ProgramData\PrehKeyTec\PKT Mapper\MappingLists\mci30.pmap</OpenFile>
<LogFile></LogFile>
<Loglevel>15</LoglLevel>
<LogFileAppend>FALSE</LogFileAppend>
<Language>de</Language>
<DateFormat>MM-dd-yy</DateFormat>
<IntercharacterDelay>0</IntercharacterDelay>
<IntercharacterDelaySlow>20</IntercharacterDelaySlow>
<IntermacroDelay>0</IntermacroDelay>
<IntermacroDelaySlow>100</IntermacroDelaySlow>
<AutoRepeatDelay>15</AutoRepeatDelay>
<AutoRepeatFirstDelay>250</AutoRepeatFirstDelay>
<FileHistoryEntries>30</FileHistoryEntries>
</SET>
</SETTINGS>
</POSKeyMapper>
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Property Description Values
Autostart Activates / deactivates the automatic start of the TRUE/FALSE
mapper after Windows® user logon
OpenlastFile Activates / deactivates the automatic opening of the | TRUE/FALSE
last used file when starting the mapper
OpenFile Full path of the file for the OpenLastFile option Full path of the
file
DeviceDetection Activates / deactivates automatic device discovery TRUE/FALSE
CheckUpdates Activates / deactivates the automatic search for TRUE/FALSE
software updates
Language Language of the MapMyKey user interface de/en
DateFormat Global date format Date format
IntercharacterDelay Text output: Delay between the output of each Delay in ms
character (Default)
IntercharacterDelaySlow | Text output: Delay between the output of each Delay in ms
character (Slow Output)
IntermacroDelay Shortcuts: Delay between the output of each macro Delay in ms
(Default)
IntermacroDelaySlow Shortcuts: Delay between the output of each macro Delay in ms
(Slow Output)
AutoRepeatFirstDelay Auto Repeat: Delay after key press until the Delay in ms
beginning of the auto repeat
AutoRepeatDelay Auto Repeat: Frequency of the Auto Repeat Frequency in ms
LogFile Full path of the log file Full path of the
file
LoglLevel Height of the log level.
LogFileAppend Specifies whether the log file is overwritten on TRUE/FALSE
startup
MasterSettingsFile Parent Settings.xml file for client mode Full path of the
file
FileHistoryEntries Number of maximum backups to restore Number
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8. Macros

8.1. Standard Macros
{ALT} Alt key
{APP} GUI (Win) application key
{BACKSPACE} Backspace key - abbreviation: {BS}
{BREAK} Break key ( = CTRL + Pause)
{BROWSER_HOME} WWW Home
{BROWSER_SEARCH} WWW Search

{BROWSER_FAVORITES}

WWW Favorites

{BROWSER_REFRESH}

WWW Refresh

{BROWSER_STOP} WWW Stop
{BROWSER_FORWARD} WWW Forward

{BROWSER_BACK} WWW Back

{CAPS} CAPS-Lock

{CTRL} Ctrl key

{DATE} Insert current Date (global format)
{DATEyyyyddMM} Insert current Date (user defined format)
{DEL} DEL key (numeric keypad)

{DELAY} 0.5 sec output delay

{DELAY1000} User defined output delay in milliseconds (e.g. 1000ms)
{DIV} Division key on numeric keypad
{DOWN} Moves cursor down

{END} End key

{ENTER} ENTER key

{ESC} ESC key

{EMPTY} No action dummy

{F1} Function key F1 ... F24

{HOME} Home key

{INS} Insert key

{LAUNCH_MAIL} Mail

{LAUNCH_MEDIA} Media Select

{LEFT} Cursor left

{LALT} (left) Alt key

{LWIN} Left GUI (Win) key

{LCTRL} (left) Ctrl key

{LSHIFT} (Left) Shift key
{MEDIA_PLAY_PAUSE} Media Play/Pause

{MEDIA_STOP} Media Stop

{MEDIA_PREV}

Scan previous Track

{MEDIA_NEXT}

Scan next Track
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{MINUS} Minus key (Numeric block)
{MUL} Multiplication key (Numeric block)
{N.} Delete / Dot key (Numeric block)
{NO} Numerical block keys 0 ... 9
{NUMLOCK} NumLock key
{PAUSE} Pause key
{PGDN} Page Down
{PGUP} Page Up
{PLUS} Plus key (Numeric block)
{RCTRL} Right Ctrl key
{RETURN} RETURN key
{RIGHT} Cursor right
{RSHIFT} Right Shift key
{RWIN} Right GUI (Win) key
{SCROLL-LOCK} ScrollLock key
{SHIFT} Shift key
{SLEEP} System Sleep
{SPACE} Space Bar (in a string, this macro must be used at the end of a line)
{TAB} Tab key
{TIME} Insert current time (format: HH:mm)
{uP} Cursor up
{VOLUME_MUTE} Mute
{VOLUME_DOWN} Volume Down
{VOLUME_UP} Volume Up
8.2. MSR Macros

Macros

Description + Annotations

{MsrTrack1} Data of MSR track 1
{MsrTrack2} Data of MSR track 2
{MsrTrack3} Data of MSR track 3
8.3. Barcode Macros
{BarcodeType} Barcode type
{Barcode} Barcode data
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8.4. OCR Macros
{Type} Passport type
{Code} Country code
{PassportNo} Passport number
{Surname} Surname
{Givenname} Givenname
{Nationality} Nationality

{NationalityCode}

Nationality 3-Letter-Code

{DateOfBirth}

Date of birth

{DateOfExpiry}

Date of expiry

{Sex}

Sex

{OptionalDatal}

Optional data 1

{OptionalData2}

Optional data 2

{MRZline1} MRZ line 1
{MRZline2} MRZ line 2
{MRZline3} MRZ line 3

For the macros "Surname / Givenname / Nationality / OptionalData" you can also select the output

in uppercase / lowercase letters by appending U/L/N as following:

Lowercase:
Uppercase:
Standard:

If nothing is specified, the data is always output as it is contained in the MRZ.

e.g.: {Givennamel} - ,thomas norbert”
e.g.: {GivennameU} > ,THOMAS NORBERT*
e.g.: {GivennameN} = ,Thomas Norbert”

In addition, multiple first and last names can be output individually by selecting the respective name

in the macro as follows:

(This can also be combined with the upper / lower case described above)

First surname:
Second surname:

{Givenname[0]} = , THOMAS"
{Givenname[1]L} & , norbert”

If the selected name does not exist, nothing is output.
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9. Sample Files

During installation, a few sample files are copied to the folder C:\ProgramData\PrehKeyTec\PKT

Mapper\MappingLists\.

The sample files are read-only and can be opened as a copy.
By default, the ‘File > Open’ menu provides access to the location of the sample files.

10. Support

PrehKeyTec Support

Scheinbergweg 10

97638 Mellrichstadt

Germany Phone: +49 9776 7046 0
Support: +49 9776 7046 222

Fax: +49 9776 7046 199

Email: support@prehkeytec.de
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